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DUMPSQUEEN

QUESTION NO: 1 - (SIMULATION)
SIMULATION
Project 4 of 7: Member

Overview

You are preparing a letter to museum members announcing a new exhibit and urging them to renew their membership.
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Dinosaurs, Dinosaurs
Baldwin Museum of Science
Dear Muszeum Member:
= As vou know, we occasionally have special offers that are himited to our members onlv. This is
one of those times. Be among the first to see our new display, "Dinosaurs, Dincsaurs.”
= For the next six months our Presentation Dome 15 going to be home 1o a collection of life-sized,
interactive dinosaurs. This display has travelled the world to the delight of adults and children
| And you get to see it first!
= Current musenm patrons can register at our web site (hitp/baldwinmuseumoficience com’) to
3 see the display before it 1s opened to the public. Be one of the first 200 patrons to register and you get
¥ to se2 it absolutely free! This offer is available to mdividual and family memberships only.
i As long as you're going to the web site, now i1z a great time for you to renew vour membership
T for the coming vear. Remember that we offer indivadual, famaly, and group memberships with special
discounts for school groups. Renew now and get a special gift you're sure to love
e Free passes are poing to po quick, 50 be sure and register today.
2 Looking forward to seetng you,
. Membership chairman

Use a Word feature to replace each occurrence of the text “patrons” with “members”.
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ANSWER: See the explanation below.

Explanation:

1. Choose Replace from the Home tab.

OR

1. Press Ctrl+H

2. Type “patrons” in the Find what box.

3. Type “members” in the Replace with box.

4. Choose Replace All since each occurrence is required to be changed.

References: https://support.office.com/en-us/article/Find-and-replace-text-c6728c16-469e-43cd-afe47708c6c779b7

QUESTION NO: 2 - (SIMULATION)

SIMULATION
Project 6 of 7: Recall
Overview

You work in Customer Communications at Northwind Traders. You are preparing a product recall announcement.
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Product Recall Announcement

Magic Dehydrator

Cur manufacturer has informed us that a small number of our Magic Dehydrators,

product number TBO1233-34, shipped with a potentially faulty heat regulator. Products
impacted by this recall include serial numbers 1514399 through LS16358.

UNFLUG AND DO NOT USE THIS DEHYDRATOR

-

We regret any inconvenience that this might cause you. Northwind Traders is dedicated to providing you with reliable, high-
quality, and safe products.

The product sticker on the bottom of the dehydrator can determine whether or not your dehydrator is included in the recall.
For affected models, there is a slight risk that the product might overheat when used, resulting in a potential burn hazard.

DO NOT RETURN TO YOUR RETAILER. Go to the Northwind traders web site at http:// www.northwindtraders.com/ and
click on the “Product Recall” banner at the top of the page for return instructions. You will receive a full refund for the
dehydrator and we will also ship you a replacement dehydrator.

REMINDER:

Add a bookmark named “Return” to the paragraph “DO NOT RETURN... replacement dehydrator.”

ANSWER: See the explanation below.

Explanation:
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1. Select the paragraph “DO NOT RETURN...replacement dehydrator.” which is where you wantto insert the bookmark.

2. Select Bookmark from the Insert tab.
3. Type “Return” under Bookmark name as desired, then click Add.

References: https://support.office.com/en-us/article/Add-or-delete-bookmarks-in-a-Word-document-or-Outlookmessage-
f68d781f-0150-4583-a90e-a4009d99¢c2a0

QUESTION NO: 3 - (SIMULATION)

SIMULATION
Project 2 of 7: Bakery Letter

Overview

As the marketing manager for Liberty’s Delightful Sinful Bakery and Café, you want to inform local businesses that you will
now be providing catering services.
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Bakery & Café

December 31, 2018
CATERING SERVICES ARE NOW AVAILABLE Dear Business Owner:

Liberty’s Delightful Sinful Bakery and Café would like to inform you that beginning next month, we will be providing catering
and delivery services in your area. We invite you to look over our lunch catering menu below, and contact us to schedule
your next business meeting lunch.
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Meal Price
Box Lunch $9.95
Includes a signafure sandwich, chips,
fruit or pasta salad, and a cookie

Signature Salad $6.95
Includes a signature salad and cookie

Soup and Salad Combo $8.95
Includes a small soup, full size salod,

and cookie

Add-ons $1.50-§2.50

20 oz. soda, dessert, chips, pasta or
fruit salod

The menu above is a small sample of the options we have available. Liberty’s Delightful Sinful Bakery will impress you with
excellent service and great food at an affordable price. We look forward to hearing from you to cater your next meeting.
Sincerely,

Steve Lasker Owner

Add a Registered Sign at the end of the company name in the header.

ANSWER: See the explanation below.

Explanation:

1. Double click on the header to edit the header, then select the text after the company name already existing in the header.
2. On the Insert tab, select Symbol.

3. Click on the desired symbol, if it is not immediately visible you may have to click More Symbols, the short cut for a
registered trademark symbol is; Ctrl+Alt+R.

References:

https://support.office.com/en-us/article/Insert-copyright-and-trademark-symbols-F417DDFE-B767415D-871F -
95AF27FB9052#IDOEAAAABAAA=Newer_versions

QUESTION NO: 4 - (SIMULATION)

SIMULATION
Project 3 of 7: Service
Overview

You are an administrative assistant for Fabrikam, Inc.’s Field Service division. You are preparing the monthly newsletter to
be sent out to field service engineers.

DumpsQueen - Pass Your Next Certification Exam Fast!
dumpsqueen.com


https://dumpsqueen.com/

DUMPSQUEEN

Service docx - Word
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Fabrikam, Inc.

Field Service Notes

B This is the last month that we'll be mailing
the field service update notes to vour office.
Starting next month, updates will be availahle at http/fwww fabrikam com/!. You will still
be responsible for information published in the update!

Remember that mileage reimbursement claims must be submitted by the 15th of each month. Save the mileage form as a
PDF file and email it to your regional supervisor.

Bonuses are Changing
New Depot Return Process

All offices have received the new tracking form for repair depot returns. Complete the following tasks when returning parts for
repair:

Complete all fields in the Field Service section of the form.
Remove the top copy and file it in your office.

Securely attach the form to the part.

Package the part for shipment.

Ship to the home office and clearly label the box “For depot return”.

All returns must be shipped to the home office to receive credit. The regional depots will close in two months and will not be
accepting return shipments.

Vice President’s Corner

NOTE TO SELF: If the VP doesn’t provide content by Wednesday, delete this section and put in something generic about
customer satisfaction.

Quarterly Results

NOTE TO SELF: This is a placeholder charter. Update the chart after the actual results are available on Monday.
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Under the “New Depot Return Process” heading, format the five lines of text starting with “Complete all fields...” as a
numbered list that has a parenthesis after the number.

ANSWER: See the explanation below.

Explanation:

1. Select the text you want to change into a list, in this case the five lines of text starting with“Complete all fields...”.
2. Go to Home, then select Numbering, then select Define New Number Format.

3. Select the desired font size, style and color.

4. Append the numbering with a parenthesis in the Number format field.

5. Ensure that the formatting and alignment is as desired, then click OK.

References:

https://support.office.com/en-us/article/Define-New-Bullets-Numbers-and-Multilevel-Lists6c06ef65-27ad-4893-80c9-
0b944cb81f5f#number

QUESTION NO: 5 - (SIMULATION)

SIMULATION
Project 5 of 7: Housekeeping
Overview

You are helping to write training program modules for Contoso Suites. You are editing the second module for housekeeping
associates.
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Contoso Suites

New Hire Training Program

Housekeeping - Part 2

Your primary responsibility as a housekeeping associate is

cleaning and restocking guest rooms. This means that vou have an important role in ensuring the
quality of our guests’ stay at Contoso Suites. As vou learned in Part 1 of your training, guest
recommendations and word-of-mouth are our best advertising, and help to grow our business.

Start of Shift

The first thing you should do when you start your shift is check your schedule. The shift supervisor will provide you with a
printed schedule listing the rooms for which you are responsible, and a recommended order for cleaning the rooms. Unless
an early cleaning is requested by the guest, check-out rooms are given priority so that we can prepare them for the next
guests. Use the inventory checklist attached to your cleaning cart to make sure that your cart is fully stocked before you
begin your rounds.

We realize that you may not be able clean a
room, for example, if a guest requests that you
not clean the room. If you are unable to clean a

room, you must inform your supervisor.

Room Cleaning

When you are ready to clean a room, knock and announce yourself as “Housekeeping.” Give the guest sufficient time to
respond (10 to 15 seconds). If the guest does not respond, let yourself into the room and begin cleaning.

Start by cleaning the common room and sleeping areas. It is best to follow consistent steps when cleaning rooms. This will
help to prevent you from missing anything. In the common room and sleeping area:

1. Pick up and dispose of any trash.

2. Empty trash cans.

3. If the guest has checked out, replace the sheets on each bed with fresh sheets.
4. Make the bed.

5. Leave a “Contoso Special Treat” on each pillow.
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6. Dust all wooden furniture.

7. Clean the coffee station (if necessary) and restock coffee, cups, and condiment packs.

8. Vacuum the common room and sleeping areas.

Do not open the courtesy bar. Checking and restocking the courtesy bar is the shift supervisor’s responsibility.

It is important that you give special attention to the restrooms. The most common guest complaint is about restroom
cleanliness. We recommend a “top-down” cleaning method for restrooms:

1. Clean all mirrors.

2. Clean countertops and sinks.

. If damp, wipe down the shower and shower curtain.
. If necessary, replace toilet paper.

. Replace used towels and wash cloths.

o o0~ W

. Pick up any trash and empty trash cans.

7. Sweep the restroom floor and mop if necessary.

Final Check

Make a final check of the room before leaving.

= Are the lights turned off?

= Are the TV and coffee station turned off?

= |s all trash picked up and disposed of? = Is the restroom door closed?

Close the door firmly and make sure that it locks behind you. Text your supervisor with the room number.
End-of-Shift

When you are finished, dispose of all trash in the large receptacles. Drop all sheets, towels, and other lines into the laundry
carts. Restock your cart so that it is ready for the next shift.

If you have more than 30 minutes left after you have completed your assigned rooms, contact your supervisor for additional
assignments.

Please take the online quiz, "Housekeeping Quiz

- F

, then continue to Housekeeping-Part 3.

One the second numbered list that begins with “1. Clean all mirrors”, modify the list to start numbering at “9”.

ANSWER: See the explanation below.

Explanation:

1. Double-click the numbers in the list which begins with “1. Clean all mirrors”.
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2. Right-click on the number 1.
3. Select Set Numbering Value.
4. Then choose the number 9 in the Set value to box.

References: https://support.office.com/en-us/article/Change-the-numbering-in-a-numbered-list-A97311378A85-47CE-A7E4-
8B1C6C8C77A3
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